Version 17

New Features in JMP 17

“The real voyage of discovery consists not in seeking new landscapes, but in having new eyes.”

Marcel Proust
The correct bibliographic citation for this manual is as follows: JMP Statistical Discovery LLC 2022. *New Features in JMP® 17*. Cary, NC: JMP Statistical Discovery LLC

**New Features in JMP® 17**

Copyright © 2022, JMP Statistical Discovery LLC, Cary, NC, USA

All rights reserved. Produced in the United States of America.

JMP Statistical Discovery LLC, SAS Campus Drive, Cary, North Carolina 27513-2414.

October 2022

JMP® and all other JMP Statistical Discovery LLC product or service names are registered trademarks or trademarks of JMP Statistical Discovery LLC in the USA and other countries. ® indicates USA registration.

Other brand and product names are trademarks of their respective companies.

JMP software may be provided with certain third-party software, including but not limited to open-source software, which is licensed under its applicable third-party software license agreement. For license information about third-party software distributed with JMP software, refer to [http://support.sas.com/thirdpartylicenses](http://support.sas.com/thirdpartylicenses).

---

### Get the Most from JMP

Whether you are a first-time or a long-time user, there is always something to learn about JMP.

Visit JMP.com to find the following:

- live and recorded webcasts about how to get started with JMP
- video demos and webcasts of new features and advanced techniques
- details on registering for JMP training
- schedules for seminars being held in your area
- success stories showing how others use JMP
- the JMP user community, resources for users including examples of add-ins and scripts, a forum, blogs, conference information, and so on

[jmp.com/getstarted](http://jmp.com/getstarted)
Contents
New Features in JMP 17

General Enhancements ................................................................. 7
Column Properties ................................................................. 7
Data Table .............................................................................. 8
Display Box Properties ............................................................. 8
Format ...................................................................................... 8
Genomics .................................................................................. 9
Host Interface .......................................................................... 9
Import and Export .................................................................... 9
Preferences ............................................................................... 10
Recode ....................................................................................... 10
Sample Data ........................................................................... 10
Transform Columns .................................................................. 11
Workflow Builder ...................................................................... 11
JMP Live ................................................................................... 11
Interactive HTML ..................................................................... 12
Basic Analysis ........................................................................... 12
Contingency ............................................................................. 13
Distribution ............................................................................ 13
Oneway .................................................................................... 13
Bivariate .................................................................................. 13
Tabulate .................................................................................... 13
Text Explorer ........................................................................... 13
Graphing .................................................................................. 14
Graph Builder ........................................................................... 14
Maps ........................................................................................ 15
Scatterplot 3D .......................................................................... 15
Profilers .................................................................................... 15
Profiler ..................................................................................... 15
Design of Experiments ............................................................ 16
Accelerated Life Testing ............................................................ 16
Custom Design .......................................................................... 16
Easy DOE .................................................................................. 16
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSA Design</td>
<td>16</td>
</tr>
<tr>
<td>Sample Size Explorers</td>
<td>16</td>
</tr>
<tr>
<td>Space Filling Designs</td>
<td>17</td>
</tr>
<tr>
<td>Fitting Linear Models</td>
<td>17</td>
</tr>
<tr>
<td>Generalized Linear Mixed Models</td>
<td>17</td>
</tr>
<tr>
<td>Generalized Regression</td>
<td>17</td>
</tr>
<tr>
<td>Mixed Model</td>
<td>17</td>
</tr>
<tr>
<td>Nominal Logistic</td>
<td>17</td>
</tr>
<tr>
<td>Standard Least Squares</td>
<td>17</td>
</tr>
<tr>
<td>Stepwise</td>
<td>18</td>
</tr>
<tr>
<td>Predictive and Specialized Modeling</td>
<td>18</td>
</tr>
<tr>
<td>Explore Outliers</td>
<td>18</td>
</tr>
<tr>
<td>Fit Curve</td>
<td>18</td>
</tr>
<tr>
<td>Functional Data Explorer</td>
<td>19</td>
</tr>
<tr>
<td>Model Screening</td>
<td>19</td>
</tr>
<tr>
<td>Nonlinear</td>
<td>19</td>
</tr>
<tr>
<td>Predictor Screening</td>
<td>19</td>
</tr>
<tr>
<td>Response Screening</td>
<td>19</td>
</tr>
<tr>
<td>Multivariate Methods</td>
<td>20</td>
</tr>
<tr>
<td>Hierarchical Cluster</td>
<td>20</td>
</tr>
<tr>
<td>Multivariate</td>
<td>20</td>
</tr>
<tr>
<td>Multivariate Embedding</td>
<td>20</td>
</tr>
<tr>
<td>Partial Least Squares</td>
<td>20</td>
</tr>
<tr>
<td>Principal Components</td>
<td>21</td>
</tr>
<tr>
<td>Structural Equation Models</td>
<td>21</td>
</tr>
<tr>
<td>Quality and Process Platforms</td>
<td>21</td>
</tr>
<tr>
<td>Control Chart Builder</td>
<td>21</td>
</tr>
<tr>
<td>EWMA Control Charts</td>
<td>22</td>
</tr>
<tr>
<td>Manage Specification Limits &gt; Manage Limits</td>
<td>22</td>
</tr>
<tr>
<td>Measurement Systems Analysis</td>
<td>22</td>
</tr>
<tr>
<td>OC Curves</td>
<td>23</td>
</tr>
<tr>
<td>Process Screening</td>
<td>23</td>
</tr>
<tr>
<td>Type I Gauge Analysis</td>
<td>23</td>
</tr>
<tr>
<td>Variability Chart</td>
<td>23</td>
</tr>
<tr>
<td>Reliability and Survival</td>
<td>23</td>
</tr>
<tr>
<td>Degradation</td>
<td>23</td>
</tr>
<tr>
<td>Fit Life by X</td>
<td>24</td>
</tr>
<tr>
<td>Life Distribution</td>
<td>24</td>
</tr>
<tr>
<td>Recurrence Analysis</td>
<td>24</td>
</tr>
<tr>
<td>Repeated Measures Degradation</td>
<td>24</td>
</tr>
</tbody>
</table>
New Features
This document describes specific updates to JMP 17. For an overview of the major new features in JMP 17 and information about how to get the release, visit jmp.com/jmp17.

General Enhancements

This section describes general enhancements and updates to JMP. For details, see the Using JMP book.

- If you are not sure where to find a statistical procedure, do a search across JMP by selecting Help > Search JMP. Results are tailored to the window that you launch the search from, such as a data table or a report.
- The IOM interface to SAS 9.3 is no longer supported.

Column Properties

- There is a new property, MSA, that stores information that can be used in the Measurement Systems Analysis, Type 1 Gauge, and Variability Chart platforms.
- For platforms that also assign a Std Error column property to a saved standard error formula column, the Predicting column property now contains an ID clause. The ID number in the Predicting column property matches the ID number in the Std Error column property of the corresponding standard error formula column. These ID numbers are used by the Prediction Profiler platform and are especially useful when there are multiple prediction formula columns and standard error formula columns.
- There is a new column property, Std Error, that is automatically assigned when you fit a model to a continuous response and save a formula column that calculates the standard error of the predicted values. The Std Error column property contains an ID clause and a DF clause.
- There is a new column property, Expand Intermediates, that is assigned to saved formula columns that refer to intermediate formula columns. The corresponding intermediate formula columns are assigned the Intermediate property. When formula columns with the Expand Intermediates column property are specified in the Profiler, JMP automatically
profiles them using the original factor columns. The Expand Intermediates column property overrides the Expand Intermediate Formula option in the profiler launch.

Data Table

- You can now join or concatenate two or more character columns to create a new column with the values separated by an underscore. Select the columns, right-click, and then select New Formula Column > Character > Concatenate with Underscore.
- The Log2 and Log2(x+1) logarithms can be applied to a column of data. Right-click the column name and select New Formula Column > Log and select either Log2 or Log2(x+1).
- In the data table operations for Summary, Subset, Sort, Stack, Split, Transpose, Join, Update, and Concatenate, a preview of the result of the table operation is shown in the table operation dialog window.
- You can use JSL to work with and inspect a smaller amount of data, performing analysis on it before doing the same analysis on large data tables. For example,

```
dt = Open( "$Sample_Data/<sample_data_tablename>.jmp", first( 10 ));
dt = Open( "$Sample_Data/<sample_data_tablename>.jmp", last( 10 ));
dt = Open( "$Sample_Data/<sample_data_tablename>.jmp", random( .5 ));
```

Display Box Properties

- In JMP reports, you can view and copy the path to the display boxes in the report by opening the report properties pane. You can view and copy the path in either XPath form or with the nested display elements subscripted form.

Format

- You can define semantic formats in reports. This enables you to override the default numeric formats by defining a format and the context in which it will be used. You can also override the default formats in specific reports and set the decimal place. The criteria for matching contexts include column name, outline names, report name, and row labels. Matches with wildcards are supported.
- You can choose to align decimal separator numbers by the decimal point in Num Col Displays and Matrix Displays. The option can be set using the right-click menu and JSL.
- There are more style options to choose from for fitted lines.
Genomics

- Marker Simulation simulates the progeny from a specified set of crosses using biallelic markers and predictor formulas (predictive models) saved in your data table. This process enables you to test various crosses to estimate which crosses will generate progeny with the desired combinations of traits.
- The Marker Statistics platform provides a convenient method for exploring several properties of all the biallelic markers in a data set, for the purpose of quality control (QC) and possibly selecting markers to be removed from the analysis.

Host Interface

- If your HDF5 file contains many data sets and you want to import only a subset of them, the regex filter enables you to select a subset using a regular expression.

Import and Export

- You can now import data files from an OSIsoft PI Server.
- In the Excel Import wizard, you can now control Numeric and Character data types.
- The Text Import wizard now displays row numbers when previewing a table. This makes it easier to determine the number of header rows to skip.
- By default, in the Open Data File window, the “Use default program to open. Uncheck to open as text” option is not selected.
- On Windows, if you import an EUC-KR or Windows-949 file while in the Korean locale, JMP will recognize it in Korean. If you are in another locale, you have to manually select the Windows-949 encoding.
- If you have data with multiple-response columns, all possible responses will be captured, even if they do not appear in the data.
- You can apply the SAS Name and SAS Label properties to a column in JMP and save the table as a transport file. During an export, the SAS Name and SAS Label column properties are respected for saving the table at SAS transport time.
- A new JSL option has been added that supports the “Use Labels for Var Names()” SAS Import Option, specifically V8 XPT.
- The ability to add the "Members" keyword to JSL open for SAS export files. You can specify a single table member as a string, or multiple members as a JSL list.
- To configure text import for data where some data columns do not have column names, go to File > Preferences > Text Data Files and change the value of the Column names start applying to column option.
Preferences

- You can filter preferences based on which version of the JMP product they were added. Filtering by version can be helpful if you want to see all the latest preferences. The Version link is available in the Preferences window and the Scripting Index.
- Your JMP preferences are remembered if you switch the JMP display language.
- You can save your current platform settings as your preferences. From a platform, click the red triangle menu and select **Platform Preferences > Save Changes to**.
- You can add new common orderings and disable the existing orderings. This includes month names, days of the week, and Likert.
- You can configure the Jitter option by setting a default setting for your scatterplots in Graph Builder. From the Preferences menu, navigate to **Platforms > Graph Builder > Jitter**. Select the appropriate option from the drop-down list.
- You can change the default line width for box plots across the platforms. Click **File > Preferences > Graphs > Box Plot Line Width**.

Recode

- The recoding tool supports expression columns.
- The ability to save the Recode Column Names script is now available.

Sample Data

- Cognitive Ability I.jmp and Cognitive Ability II.jmp demonstrate correlation and covariance matrices in the SEM platform.
- Life Sciences/Genotypes Pedigree.jmp and Life Sciences/Genotypes Pedigree Anno.jmp are added for the Marker Statistics platform.
- Impurity Process Capability with Detection Limits.jmp illustrates the new limit of detection feature in the Distribution platform and that the limit of detection can affect your process capability analysis.
- Reliability/Alloy A.jmp is used for the newly developed Repeated Measures Degradation platform.
- Penguins.jmp can be used with the principal components analysis (PCA), Plot 3D, Clustering, and Graph Builder applications.
- Quality Control/Electrical Component Defect Screening.jmp and Quality Control/Water Plastics.jmp demonstrate Laney charts.
- Dissolution DoE Verification Runs.jmp and Dissolution DoE.jmp support dissolution curves in Fit Curve.
• Method Comparison.jmp demonstrates Passing-Bablok regression and is added to the Bivariate platform.
• Functional Data/NMR DoE.jmp demonstrates the new wavelets feature in Functional Data Explorer (FDE).
• Student Testing.jmp demonstrates the new generalized linear mixed models (GLMM) personality in Fit Model.
• Manufacturing Defect Counts.jmp demonstrates the new generalized linear mixed models (GLMM) personality in Fit Model.
• Powder Metallurgy.jmp can be used for a variety of modeling platforms.
• Hardware Surface Unit Data.jmp demonstrates exploratory data analysis.

Transform Columns

• You can use transform columns in more places in a script.
• You can create a new formula column by specifying the operation name, instead of having to provide the formula. The category name is needed only if the operation name is not unique in the transform menus.

Workflow Builder

• If you often execute the same tasks in JMP, you can now capture your workflow with Workflow Builder. Workflow Builder is like an advanced macro that records your actions in JMP so that you can replay them or share them with others.

JMP Live

This section describes new features and enhancements to JMP Live. For details, see the JMP Live Help.
• All posts and folders in JMP Live are now contained in spaces. Spaces are created by JMP Live administrators and can be maintained by anyone with administrative permission.
• The new web-based publishing interface makes publishing to JMP Live simpler.
• In addition to publishing reports to JMP Live as posts, you can now publish data as posts. You can also set data to be downloadable or not.
• You can view a data table in JMP Live from a data post.
• You can refresh data on demand and you can create schedules for refreshing data.
• You can add any number of folders under a folder.
• You can add groups within a group.
• You can open a JMP Live post in JMP. The content is downloaded to your machine and opens in JMP as a JMP Project.
• You can click and drag to resize graphs and dashboards.
• In Data Filters and Column Switchers, any selections you make are captured in the URL. You can copy and paste the URL to share your selections with people.
• In a Data Filter, you can turn off automatic updating and update your selections manually instead.
• A new Best Performance option can increase responsiveness in reports that use large data sets. Graphs and images are static, but supported data in the rest of the report remains interactive.

Interactive HTML

This section describes new features and enhancements to interactive HTML reports. For details, see the interactive HTML Help.

• The Inverse option has been added to Local Data Filters. This option works identically to the corresponding option in JMP.
• Prediction profilers for categorical responses are now supported.
• The Naive Bayes profiler platform is now supported.
• Parallel plots created in Graph Builder are now supported.
• Packed bar charts are now supported.
• Customized font sizes are now supported.
• Dark mode (theme) is now supported.
• In Graph Builder legends, you can now select items and the corresponding elements are highlighted in the graph.
• Graphs are clearer when zoomed in.
• Text and cell background colors in tables are now supported.

Basic Analysis

This section describes new features and enhancements to the general analysis platforms. For details, see the Basic Analysis book.
Contingency

- The Contingency platform now supports equivalence tests for relative risks and for risk difference. You can perform superiority and noninferiority tests as well.

Distribution

- The Distribution platform now supports the Detection Limits column property to accommodate censored observations for fitted distributions.

- The Distribution platform now has summary statistic options to calculate $3\times$Std Dev, Mean + $3\times$Std Dev, and Mean - $3\times$Std Dev.

Oneway

- Equivalence, superiority, and non-inferiority tests are available in the Oneway platform. You can perform these tests on means as well as standard deviations. All of these tests have forest plots available.
- In addition to JMP Pro, exact tests are now also available in JMP.

Bivariate

- The Bivariate platform now includes Passing Bablok regression.

Tabulate

- You can now pack multiple statistics or analysis columns into a single display column in a Tabulate report.
- You can now stack grouping columns.
- You can use an ID column to calculate stacked grouping category statistics.

Text Explorer

- The Text Explorer platform now supports Korean.
Graphing

This section describes new features and enhancements in the graphing platforms. For details, see the *Essential Graphing* book.

**Graph Builder**

- To assist with color blindness, protanomaly, deuteranomaly, and tritanomaly color theme filters are now available.
- The sampling feature enables you to choose a proportion, rather than an integer value.
- You can relabel levels, combine levels into groups, and reorder levels on the axis without having to edit the column properties.
- Mode statistic is now an option in the Summary Statistic report. This option affects coloring by the dominant level. To access this option, go to *Graph > Graph Builder > Points*. Choose Mode from the Summary Statistic list.
- Support is added for multiple response data. Multiple response columns can be used in each of the Graph Builder zones.
- You can use the hash pattern style indicator for bar charts.
- In bar charts, you can show one-sided confidence intervals. To access this option, right-click on a bar chart > Customize > Error Bar. Choose the Upper or Lower option from the Interval Sides list.
- If a continuous variable is used as the overlay variable, you can customize the bin values for the gradient. To access this option, right-click on the gradient in the legend > Gradient. Choose Custom in the Scale Type list and then change the level values.
- There are new ways to associate summary text in graphs and axes. For example, you can now display associated summary tabular data along the axes in Graph Builder. You can also change the position of the caption box. To access this option, change the X and Y position in the Caption Box options. You can customize the location of text in a caption or text box by right-clicking in the box > Customize > Text.
- JSL references to Graph Builder are now updated when starting over.
- You can now show the coefficient of variation (CV) statistic by selecting it in the Summary Statistic list.
- You can change the default color of histogram bars or outlines. To access this option, select *File > Preferences > Styles*. Choose a color for the Histogram Fill Color and Histogram Line Color.
- The Constrain Parameters option is now available for Exponential Smoothing (ETS) fits.
• You can hide points with missing values for size or color. To access this option, right-click on a graph > **Customize** > **Marker**. Select **Hide Missing Color** or **Hide Missing Size**.

• In treemaps, you can adjust the tile aspect ratio using the Orientation Bias slider.

• In treemaps, you can click and drag to select multiple rectangles.

• In treemaps, you can now customize group labels. To access these options, right-click on a treemap > **Customize** > **Treemap**. Change the group label font, font color, label color, or border color.

**Maps**

• Very small shapes on a map can be made visible with a dot. To access this option, right-click on a map > **Customize** > **Shape: X** and choose **Use dots for extremely small shapes**.

• JMP now supports SAS and MapBox OSM servers.

**Scatterplot 3D**

• You can now hide data on axes but keep the variable names. To access this option, double-click on an axis and deselect the **Labels** option for major or minor axes.

**Profilers**

This section describes new features and enhancements in the Profiler platforms. For details, see the **Profilers** book.

**Profiler**

• There is a new feature available in the red triangle menu of the Prediction Profiler called the Design Space Profiler. Use the Design Space Profiler to automatically and interactively find limit of failure regions and/or operational ranges inside the factor space where the model(s) predict that the response(s) will be within specification.

• There are new distributions available in the Simulator for mixture factors: Mixture Uniform and Mixture Dirichlet.

• The Prediction Profiler has a new option that enables you to compute Shapley Values for all of the independent variables in a predictive model and add them to the current data table via the prediction profiler. Shapley values help to understand the contribution of independent variables in a predictive model.
Design of Experiments

This section describes new features and enhancements in the DOE platforms. For details, see Design of Experiments Guide.

- DOE factor and response tables now support units. The units are stored in a column property.

Accelerated Life Testing

- There is an updated workflow for accelerated life tests.

Custom Design

- The user can set the number of starts used to search for an optimal design.
- The custom designer now allows for the comparison of up to 5 alternative designs for the same factor set within the design window.

Easy DOE

- Easy DOE is a new platform designed for those new to DOE. The platform guides the user through all the steps in designing and analyzing an experiment. All the information, the data and metadata, and the user selections are maintained within a single object, and all of it can be saved between JMP sessions as a *.jmpdoe file. Easy DOE has a guided and a flexible mode to support different types of users.

MSA Design

- The MSA designer now supports nested factors.
- The MSA designer has an updated design diagnostics interface.

Sample Size Explorers

- The user interfaces have been updated for all sample size explorers.
- The sample size explorers now includes options for reliability life tests, non-inferiority and superiority tests, counts per unit, and sigma quality level.
- The explorers includes the ability to simulate data based on the study settings.
Space Filling Designs

- Space filling designs now support discrete numeric factors.

Fitting Linear Models

This section describes new features and enhancements in the Fit Model personalities. For details, see the *Fitting Linear Models* book.

**Generalized Linear Mixed Models**

- The new Generalized Linear Mixed Model personality enables you to fit mixed models in the context of generalized linear models. You can fit Poisson or binomial response distributions with fixed and/or random model effects.

**Generalized Regression**

- You can now save the standard error of the predictions as a formula column.
- The beta distribution now supports censoring.
- Self-validated ensemble models (SVEM) have been added for forward selection and the Lasso.

- Interval estimation now uses $t$-quantiles.

**Mixed Model**

- The Mixed Model personality now supports multiple Y columns.

**Nominal Logistic**

- The Nominal Logistic personality now supports multiple Y columns.

**Standard Least Squares**

- Multiple Comparisons are now available from the top-level of the Fit Least Squares red triangle menu.
• Equivalence tests are now available directly from the Multiple Comparisons launch window. The equivalence tests have been updated to include equivalence tests, superiority tests, and noninferiority tests.
• The eta-squared and omega-squared effect size index statistics are now available in the Effects Tests table.
• Extrapolation Control is now available in standard JMP when you launch the profiler through the Standard Least Squares platform.

**Stepwise**

• The All Possible Models table now includes a validation set R-square statistic.

---

**Predictive and Specialized Modeling**

This section describes new features and enhancements in the advanced Modeling platforms. For details, see the *Predictive and Specialized Modeling* book.

**Explore Outliers**

• There is a new option for the Robust PCA Outliers method that uses the Randomized SVD method instead of the Lanczos method to decompose the data.

**Fit Curve**

• Fit Curve now supports data in the following formats: rows as functions and columns as functions. The stacked data format is still supported.
• There are several new models available in the Fit Curve platform including rate equation models, parametric dissolution curve models, the Power Model, the Hybrid Exponential, the Inverse Michaelis-Menten, the Antoine Equation, ExGaussian, the Peak Model, and a three-parameter Probit model.
• The parameterizations of the Probit models and the Michaelis-Menten model have been updated.
• Dissolution Curve Analysis is now available in the Fit Curve platform. Compare dissolution curves using built-in parametric dissolution curve models or use one of the following model-free comparison techniques: F1 Analysis, F2 Analysis, or Multivariate Distance.
New Features

Highlights in JMP 17
Predictive and Specialized Modeling

**Functional Data Explorer**

- A new collection of options for pre-processing data has been added to Functional Data Explorer. The Spectral pre-processing tab contains the following methods that are useful for pre-processing spectral data: the Savitsky-Golay filter and its first and second derivatives, the Standard Normal Variate (SNV) method, the Multiplicative Scatter Correction (MSC) method, and the Baseline Correction method.
- Wavelet basis function models are now available in Functional Data Explorer.

**Model Screening**

- The options in the Model Screening launch window have been reorganized.

**Nonlinear**

- The Nonlinear platform contains a new option called Custom Estimation Profiler. This option is used to construct a profiler for a custom expression.

**Predictor Screening**

- You can now save the predictor ranking table from the report to a new data table using the Save Results option.

**Response Screening**

- The Response Screening report has been reorganized. There is now a section for all of the plots and a section for all of the tables. Red triangle menu items enable you to show or hide all plots or all reports.
- A Switch column role is now available for Fit Response Screening. This is accessible through the Fit Model dialog when the Response Screening personality is specified. This column role specifies columns to be switched, one at a time, into the model.
- There are volcano plots in the Response Screening platform. The Logworth by Difference plot is available when there is at least one continuous response and at least one categorical X variable. The Logworth by Slope plot is available when there is at least one continuous response and at least one continuous X variable. Both types of volcano plots require that the data be on the same scale. There are two new options in the launch window, Common X Scale and Common Y Scale, to notify the platform.
- To analyze practical differences, there is now a Practical Differences and Equivalences option in the red triangle menu of the Response Screening report. Previously you specified
practical differences in the launch window. When you select this new option, a window appears that enables you to specify how the practical differences are calculated.

**Multivariate Methods**

This section describes new features and enhancements in the Multivariate Methods platforms. For details, see the *Multivariate Methods* book.

**Hierarchical Cluster**

- There is a new computing approach to Ward’s method called Hybrid Ward. This method is useful when you have tens or hundreds of thousands of items to cluster. There is a section of advanced options specifically for the Hybrid Ward method.
- The Hierarchical Cluster launch window has been updated. You can now standardize by columns, rows, or columns and rows. You can also specify Two Way Clustering in the launch window as well.
- The Late Join Outliers option enables you to view observations that were clustered very late in the algorithm. This can indicate potential outliers in the data set.

**Multivariate**

- The Partial Correlation Diagram option performs an eigenvalue decomposition on the partial correlation matrix and uses the results to give a visual representation of the partial correlations. Highly correlated pairs of columns are near each other.

**Multivariate Embedding**

- There is a new platform, Multivariate Embedding, that enables you to map data from very high dimensional spaces to a low dimensional space. The Multivariate Embedding platform uses the t-Distributed Stochastic Neighbor Embedding (t-SNE) method. This method attempts to fill the low dimensional space in such a way that clusters of near neighbors can be more easily identified.

**Partial Least Squares**

- There is a new option in the Partial Least Squares platform that enables you to launch the Profiler for the prediction formulas.
New Features

Highlights in JMP 17

Quality and Process Platforms

Principal Components

- The Principal Components launch window has been restructured to make the choices clearer.
- Randomized SVD and Robust PCA are new methods that are available to perform principal components analysis on wide data. Randomized SVD is a computationally efficient way to calculate approximations of the principal components. Robust PCA reduces the effect of outliers on the principal component estimates.
- There is a new option in the Principal Components platform that enables you to launch the Profiler for the prediction formulas.

Structural Equation Models

- Multiple group analysis in the Structural Equation Models platform enable you to carry out systematic model comparisons of statistical effects across groups.
- New modeling shortcuts are available to quickly specify multivariate latent growth curve models and to switch the scale of latent variables between standardized and unstandardized.
- There are new options for heat maps to visualize the covariance and model-implied covariance estimates.
- Total and Indirect Effects tables now contain a bar plot to visualize the effect sizes.
- When you fit multiple models, you can change the model that is used as the independent model in model comparisons.
- The new Predicted Values Plot shows the model-implied distributions or trajectories, in the case of longitudinal data, for predicted variables in the model.
- Scripts from the Factor Analysis platform can now be pasted into the Structural Equation Models platform to speed up specification of confirmatory factor analysis and thus facilitate survey development.

Quality and Process Platforms

This section describes new features and enhancements in the Quality and Process platforms. For details, see the Quality and Process Methods book.

Control Chart Builder

- You can now update the sigma multiplier through the K Sigma red triangle menu option.
• A row legend is now available in the Control Chart Builder. This option colors the rows according to a specified data column and inserts a legend next to the graph. It is not available if there is a phase variable.

• There is a new Switch to IMR Chart button that moves the subgroup variable to the Label role to create an Individual and Moving Range chart. This option is available if there is only one specified subgroup variable, the chart is summarized, and the chart has a Shewhart Variables chart type.

• There are two new control charts available in the Control Chart Builder: Laney $P'$ and Laney $U'$ charts. Laney $P'$ and Laney $U'$ charts contain the same information as standard $P$ and $U$ charts, but the control limits are calculated using a moving range adjusted sigma. The Laney charts are particularly useful when the subgroup size is very large.

• There is now a label role for the horizontal axis.

**EWMA Control Charts**

• You can now update the value of $K$ Sigma in the EWMA Control Charts platform.

• You can now save the value of Sigma in the EWMA Control Charts platform.

• The Connect Thru Missing option is now available in the EWMA Control Charts platform.

**Manage Specification Limits > Manage Limits**

• The Manage Specifications utility has been updated to become the Manage Limits platform. In addition to specification limits, this platform now also handles importance values, detection limits, Process Screening metadata (centerline, control chart sigma, and measurement sigma), Measurement Systems Analysis metadata (tolerance range, lower tolerance, upper tolerance), Measurement Systems Analysis metadata specific to Type 1 Gauge analyses (reference and resolution). There is an option to edit the metadata.

**Measurement Systems Analysis**

• Linearity and bias results, misclassification probabilities, and an AIAG style Gauge R&R report are now available in the Measurement Systems Analysis platform. The AIAG Gauge R&R Results report includes an option to add the Discrimination Ratio to the report.

• MSA has improved handling of multiple responses.
OC Curves

- AQL and RQL limits and curves are now included in the single and double acceptance sampling curve explorers.

Process Screening

- The Process Screening platform is now located in the Quality and Process menu.

Type 1 Gauge Analysis

- You can now analyze measurements using the Type 1 Gauge method to evaluate the repeatability and bias of a measurement process on one reference part. Type 1 Gauge is an option in the Measurement Systems Analysis launch window.

Variability Chart

- The Variability Chart launch window has been updated. There are options to specify a Sigma Multiplier, Random Seed and whether to show the MSA Metadata Entry Dialog. You can also choose to use the specification limits for the lower and upper tolerances.
- There is now an Edit MSA Metadata menu item under the Gauge Studies submenu that can be used to change the tolerance limits, historical mean, and historical process sigma.
- In the Linearity Study, the process variation is now calculated as the sigma multiplier times the historical process sigma. An option to specify the sigma multiplier has been added to the launch window. You can specify the historical process sigma in the launch window, through the Edit MSA Metadata option, or in a script.
- The misclassification probabilities option no longer prompts you to enter specification limits. You can specify tolerance limits in the launch window, through the Edit MSA Metadata option, or in a script.

Reliability and Survival

This section describes new features and enhancements in the Reliability and Survival platforms. For details, see the *Reliability and Survival Methods* book.

Degradation

- The Stability Test analysis now supports using a pooled mean square error (MSE).
Fit Life by X

- The residual plots in the Fit Life by X platform have been updated for better interpretability.

Life Distribution

- When you fit a defective subpopulation model in the Life Distribution platform, the corresponding non-defective subpopulation model is also fit. A likelihood ratio test is also performed to compare the models.

Recurrence Analysis

- If you have previously fit a model in the Recurrence Analysis platform, the Fit Model launch in the platform now contains a Recall button.

Repeated Measures Degradation

- The new Repeated Measures Degradation platform enables you to analyze repeated measures degradation models using a hierarchical Bayesian approach. This approach represents the state-of-the-art method for analyzing repeated measures degradation data.

Scripting

This section describes new features and enhancements in the scripting area. For details, see the Scripting Guide and the JSL Syntax Reference.

- The new Random SVD function provides a fast approximate method to reduce high-dimensional data to fewer dimensions. You can specify the number of singular values in the lower dimension, as well as other parameters to control the trade off between speed and accuracy.
- You can now store JSL symbols on project and window display boxes.
- Display Boxes can now directly call methods on the class from which they were created. This enables scripts for interface controls like buttons and sliders to access data on the class.
- Among many enhancements to logging and action recording, these actions are now recorded:
  - Create-table-from-sql-query-builder
  - Column name moves
Deleting rows
Make Into Data Table
Multiple file imports
Recode Column Names
Saving and exporting platforms and journals to an image

- In addition, undo-able data table actions are now noted in the action recorder.
  HTTP Request now supports a cancellable progress bar that displays the upload/download progress from a web resource. HTTP Request also now supports JSL promises.
- The new Multi HTTP Request enables you to add multiple New HTTP Request objects and call Send or Download on all the requests at once, in parallel.
- Script generation better handles windows that were created with JSL and windows that have not been saved to a file. This improves saving output to JRP and Session files.
- New JSL options for producing a picture from a display box. The new options for GetPicture():
  - Appearance("Default" | "Current")
  - Type("Bitmap" | "Scalable")
  - View("Picture" | "Screen" | "Print")
  - SubRect(Left(int), Top(int), Right(int), Bottom(int))
- This JSL-only feature allows the creation of a private report that is not visible in the UI, but has the behavior of a window. Private reports are more computationally efficient for simulations or automated workflows that utilized existing JMP platforms.
- Three new JSL built-in functions: With Window Handler(), Set Global Window Handler(), and Clear Global Window Handler().
- The new Is Modal Dialog() returns true for modal windows and false for other types of windows.
- You can now script the font picker, most file picker dialogs, and simple host alerts (such as Yes/No and Yes/No/Cancel).
- New Window() now supports the creation of the following window types: Modal Dialog, Dialog, and Launcher.
- PlotColBox() has new color options. It also now supports a vertical line to indicate the parameter estimate, and a callback for a mouse click so that styles can be updated.
- You can now save a JMP Dashboard script that appears closer to how a JSL programmer would write it.
- You can now control the maximum matrix dimension when generating a picture with Expr As Picture().
- Check boxes have a new partial selection state. This allows for folders in a check box list to be partially selected when not all the files from that folder are selected. The partial selection state is set with Set Three State().
RadioBox buttons now support tooltips for each individual button.

ColListBox Get Selected() can now return a Column Reference.

TableBox now has a column selection dialog. Access it by right-clicking the TableBox and selecting **Columns > Column selection**.

OutlineBox titles can now be locked, and they also now support a callback for when the title changes.

Better access to JSL syntax help from the script editor. Alt+double-click a JSL function name, platform name, or object message to display the corresponding Scripting Index help.

New path variables are available:

$MAPS, $USER_JMPDATA, $USER_JMPDATA_ALL, $USER_JMPDATA/MAPS